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NetIQ Identity Manager Analyzer 4.7 enthält verschiedene Verbesserungen und Korrekturen früherer 
Fehler.

Viele der eingeführten Verbesserungen sind Umsetzungen von Vorschlägen unserer Kunden. Wir 
möchten uns auf diesem Wege bei Ihnen für Ihr wertvolles Feedback bedanken. Wir hoffen, Sie 
unterstützen uns weiterhin dabei, unsere Produkte optimal an Ihre Bedürfnisse anzupassen. 
Feedback können Sie in unseren Identity Manager Community-Foren auf unserer Community-
Website posten, auf der Sie auch Produktbenachrichtigungen, Blogs und Produktbenutzergruppen 
finden.

Weitere Informationen über die Neuheiten in früheren Versionen finden Sie im Abschnitt „Frühere 
Versionen“ auf der Dokumentations-Website zu Identity Manager.

Die Dokumentation für dieses Produkt und die aktuellen Versionshinweise finden Sie auf der NetIQ-
Website auf einer Seite, für die keine Anmeldung erforderlich ist. Wenn Sie uns einen 
Verbesserungsvorschlag in Bezug auf die Dokumentation mitteilen möchten, nutzen Sie die 
Schaltfläche comment on this topic (Kommentar zum Thema abgeben), die unten auf jeder Seite 
der auf der Identity Manager-Dokumentationswebsite veröffentlichten HTML-Version unserer 
Dokumentation verfügbar ist. 

Dieses Produkt steht auf der Website der Identity Manager-Produkte zum Herunterladen bereit.

 Abschnitt 1, „Neue Funktionen“, auf Seite 1
 Abschnitt 2, „Systemanforderungen“, auf Seite 2
 Abschnitt 3, „Installation von Analyzer 4.7“, auf Seite 2
 Abschnitt 4, „Aufrüsten auf Analyzer 4.7“, auf Seite 2
 Abschnitt 5, „Bekannte Probleme“, auf Seite 3
 Abschnitt 6, „Verwenden des Produktevaluierungsschlüssels“, auf Seite 6
 Abschnitt 7, „Kontaktangaben“, auf Seite 7
 Abschnitt 8, „Rechtliche Hinweise“, auf Seite 7

1 Neue Funktionen
Diese Version unterstützt erstmals Java 8 Update 162. 

Weitere neue Funktionen wurden nicht eingeführt.
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2 Systemanforderungen 
Weitere Informationen zu den Voraussetzungen, den Computeranforderungen sowie zur Installation, 
Aufrüstung oder Migration finden Sie in den folgenden Ressourcen:

 „Planen der Installation von Analyzer“ im Einrichtungshandbuch zu NetIQ Identity Manager für 
Linux

 „Planen der Installation von Analyzer“ im Einrichtungshandbuch zu NetIQ Identity Manager für 
Windows

3 Installation von Analyzer 4.7 
Nachdem Sie Identity Manager 4.7 käuflich erworben haben, melden Sie sich bei der Identity 
Manager-Produkt-Website an und folgen Sie dem Link zum Herunterladen der Software. Folgende 
Dateien stehen zur Verfügung:

Tabelle 1   Identity Manager-ISO-Imagedateien

Informationen zum Herunterladen der Installationskits finden Sie auf der Website NetIQ Downloads.

4 Aufrüsten auf Analyzer 4.7 
Sie können von Analyzer 4.6 auf Analyzer 4.7 aufrüsten. Weitere Informationen zu den unterstützten 
Aufrüstungspfaden finden Sie unter Vorbereiten der Aufrüstung von Identity Manager im 
Einrichtungshandbuch zu NetIQ Identity Manager für Linux bzw. im Einrichtungshandbuch zu NetIQ 
Identity Manager für Windows.

ISO Beschreibung

Identity_Manager_4.7_Linux.iso Enthält alle Identity Manager-Komponenten für Linux.

Identity Manager Server (Identity Manager Engine, 
Remote Loader, Fan-Out Agent, iManager Web 
Administration), Identitätsanwendungen, Identity 
Reporting, Designer und Analyzer

Identity_Manager_4.7_Windows.iso Enthält alle Identity Manager-Komponenten für 
Windows.

Identity Manager Server (Identity Manager Engine, 
Remote Loader, Fan-Out Agent, iManager Web 
Administration), Identitätsanwendungen, Identity 
Reporting, Designer und Analyzer

Identity_Manager_4.7_Linux_Analy
zer.tar.gz

Enthält Analyzer für Linux

Identity_Manager_4.7_Windows_Ana
lyzer.zip

Enthält Analyzer für Windows
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5 Bekannte Probleme
NetIQ Corporation ist bestrebt, Produkte zu bieten, die hochwertige Lösungen für die 
Softwarebedürfnisse Ihres Unternehmens darstellen. Die nachfolgend beschriebenen Probleme 
werden zurzeit untersucht. Wenden Sie sich an den Technischen Support (http://www.netiq.com/
support), wenn Sie weitere Hilfe zu einem Problem benötigen.

 Abschnitt 5.1, „Der SAP-Benutzertreiber benötigt zusätzliche Dateien“, auf Seite 3
 Abschnitt 5.2, „Der DB2-Treiber benötigt zusätzliche Bibliotheken“, auf Seite 3
 Abschnitt 5.3, „Vorsicht beim Ändern von Daten“, auf Seite 3
 Abschnitt 5.4, „Fehler beim Senden aktualisierter Daten an eine Anwendung“, auf Seite 4
 Abschnitt 5.5, „Beim Importieren werden von der Anwendung keine Daten angezeigt“, auf 

Seite 4
 Abschnitt 5.6, „Einige Zeichen verursachen Probleme bei der Musterfrequenzanalyse“, auf 

Seite 4
 Abschnitt 5.7, „Importieren der Verbindungen von Designer nicht möglich“, auf Seite 5
 Abschnitt 5.8, „In der Übereinstimmungsanalyse werden gelöschte Werte nicht 

ausgeschlossen“, auf Seite 5
 Abschnitt 5.9, „Import des Anwendungsschemas schlägt fehl“, auf Seite 5
 Abschnitt 5.10, „Für die Übereinstimmung wird bei Verwendung von HSQL zwischen Groß- und 

Kleinschreibung unterschieden“, auf Seite 6

5.1 Der SAP-Benutzertreiber benötigt zusätzliche Dateien
Wenn Sie den SAP-Benutzertreiber verwenden möchten, müssen Sie die Bibliothek sapjco.jar in 
Analyzer und librfc32.dll sowie sapjcorfc.dll im Windows-Ordner %systemroot% (in der Regel 
C:\windows\system32) installieren.

Starten Sie Analyzer nach der Installation dieser Dateien neu.

5.2 Der DB2-Treiber benötigt zusätzliche Bibliotheken
Der Analyzer DB2-Treiber benötigt die folgenden beiden Bibliotheken, um ordnungsgemäß zu 
funktionieren. Sie können diese Bibliotheken von IBM (http://www.ibm.com/developerworks/) 
herunterladen.

 db2java.zip
 db2jcc.jar

5.3 Vorsicht beim Ändern von Daten
Problem: Analyzer hindert Benutzer nicht daran, Daten in einer Datengruppe zu ändern. Wenn ein 
Benutzer mit den entsprechenden Rechten auf die Ursprungsanwendung einen Wert ändert, 
beispielsweise eine GUID oder einen DN, ermittelt Analyzer nicht, ob die Änderung beim Speichern 
in der Ursprungsanwendung ein Problem verursachen könnte.

Behelfslösung: Benutzer sollten daher beim Ändern von Daten und Senden dieser Änderungen an 
die Ursprungsanwendung sehr sorgfältig sein, damit in der Ursprungsanwendung keine 
unbeabsichtigten Probleme auftreten.
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5.4 Fehler beim Senden aktualisierter Daten an eine Anwendung
Problem: Beim Versuch, aktualisierte Daten an die Ursprungsanwendung des Datenbrowsers von 
Analyzer zu senden (durch Klicken auf Save to Application), erhalten Sie möglicherweise einen 
Fehler, der angibt, dass beim Aktualisierungsvorgang ein Problem aufgetreten ist. Allerdings wird im 
Datenbrowser in der Datentabelle angegeben, dass die Aktualisierungen erfolgreich durchgeführt 
wurden.

Behelfslösung: Falls dies der Fall ist, wurden die Datenaktualisierungen möglicherweise nicht 
erfolgreich durchgeführt. Importieren Sie die Daten aus der Ursprungsanwendung neu, um 
sicherzustellen, dass Sie den wahren Status der Daten kennen, bevor Sie weitere Änderungen an 
den Daten vornehmen.

Probleme beim Aktualisierungsvorgang treten in erster Linie dann auf, wenn ein Wert zu einem 
Attribut mit mehreren Werten hinzugefügt wird.

5.5 Beim Importieren werden von der Anwendung keine Daten 
angezeigt
Die folgenden Probleme können dazu führen, dass Analyzer in der Datenbrowseransicht keine 
Inhalte der Datengruppen anzeigt:

 Abschnitt 5.5.1, „Als Spaltenname wurde ein reserviertes SQL-Wort verwendet“, auf Seite 4
 Abschnitt 5.5.2, „Abonnent ist für die ausgewählte Verbindung deaktiviert“, auf Seite 4

5.5.1 Als Spaltenname wurde ein reserviertes SQL-Wort verwendet
Analyzer unterstützt keine reservierten SQL-Wörter als Spaltennamen für Datengruppen (z. B. 
„group“ oder „select“). Wenn es sich bei einem Spaltennamen um ein reserviertes SQL-Wort handelt, 
werden in der Datenbrowseransicht keine Daten angezeigt. Sie können dies verhindern, indem Sie 
die Spalte (Attribut), die als Name ein reserviertes Wort hat, aus der Datengruppe ausschließen.

5.5.2 Abonnent ist für die ausgewählte Verbindung deaktiviert
Problem: Der Abonnentenkanal von Analyzer ist standardmäßig aktiviert, damit Sie 
Datengruppenabfragen ausführen können. Wenn allerdings ein Verbindungsprofil von Designer aus 
mit deaktiviertem Abonnentenkanal synchronisiert wurde, bleibt es für Analyzer deaktiviert. Wenn 
Ihre Datengruppen über keine Daten verfügen, bestätigen Sie, dass der Abonnentenkanal des 
Verbindungsprofils in Analyzer aktiviert ist.

Behelfslösung: Klicken Sie dazu mit der rechten Maustaste auf das gewünschte Verbindungsprofil 
und wählen Sie anschließend Properties. Wählen Sie in den Verbindungsprofileigenschaften IDS 
Configuration > Parameters > Subscriber Options. Stellen Sie sicher, dass Disable subscriber auf 
No (Standard) festgelegt ist.

5.6 Einige Zeichen verursachen Probleme bei der 
Musterfrequenzanalyse
Die Musterfrequenz-Analysemetrik funktioniert nicht korrekt mit Daten, in denen die folgenden 
Zeichen enthalten sind. Wenn Sie eine Musterfrequenzanalyse mit einer Datengruppe durchführen, 
deren Daten eines dieser Zeichen enthalten, schlägt die Analyse fehl und gibt ein leeres Ergebnis 
zurück. (Bug 379384)
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5.7 Importieren der Verbindungen von Designer nicht möglich
Problem: Wenn Verbindungen nicht korrekt von Designer importiert werden, besteht das Problem 
wahrscheinlich darin, dass die dem Treibersatz in Designer zugeordnete Serverkonfiguration nicht 
korrekt oder unvollständig ist. Wenn Sie beispielsweise einen neuen Treibersatz in Designer 
erstellen, lautet der Standardserver-DN „server.context“. Wenn Sie versuchen, 
Verbindungsinformationen zu importieren, die ungültige Informationen wie diese enthalten, schlägt 
der Import fehl. (Bug 368384)
Behelfslösung: Stellen Sie vor dem Importieren von Verbindungsinformationen von Designer sicher, 
dass die Server-Informationen gültig sind.

5.8 In der Übereinstimmungsanalyse werden gelöschte Werte nicht 
ausgeschlossen
Wenn es gelöschte Werte im Datenbrowser gibt, die in der Anwendung nicht aktualisiert wurden, 
werden diese bei Ausführung der Übereinstimmungsanalyse weiterhin berücksichtigt.

5.9 Import des Anwendungsschemas schlägt fehl
Problem: Das Identitätsdepotschema unterstützt nicht mehrere Klassen mit demselben Namen. 
Einige Anwendungsschemas, wie z. B. Notes, unterstützen doppelte Klassennamen. Wenn Sie ein 
Anwendungsschema importieren möchten, das doppelte Klassennamen enthält, sollten Sie die 
doppelten Klassennnamen zuerst in eine einzelne Klasse konsolidieren, die die Attribute aller 
doppelten Klassen enthält. (403735)

Behelfslösung: Wenn Sie die doppelten Klassen im Anwendungsschema nicht auflösen können, 
können Sie sie wie folgt manuell im Analyzer auflösen:

Zeichen Beschreibung

+ Plussymbol (Additionszeichen)

* Sternchen

. Punkt

‘ Apostroph

? Fragezeichen

| Pipe-Symbol

\ Umgekehrter Schrägstrich

( ) Linke oder rechte Klammer

[ ] Linke oder rechte eckige Klammer
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WARNUNG: Dieses Verfahren wird nicht empfohlen und kann zu Inkonsistenzen im 
Identitätsdepotschema führen. Es sollte nur dann darauf zurückgegriffen werden, wenn es absolut 
notwendig ist.

1 Öffnen Sie die IDS Trace-Ansicht (Window > Show View > IDS Trace).
2 Klicken Sie in der Projektansicht mit der rechten Maustaste auf die entsprechende Verbindung 

und wählen Sie anschließend Refresh Schema.
Dadurch wird das Anwendungsschema im IDS-Trace erfasst. Falls das IDS-Trace nicht das 
komplette Schema erfasst, erhöhen Sie die Fenstergröße für IDS-Trace, indem Sie auf das 
Symbol Preferences klicken und anschließend die Einstellung Maximum lines to retain erhöhen.

3 Öffnen Sie die Navigatoransicht (Window > Show View > Navigator).
4 Erweitern Sie in der Navigatoransicht das entsprechende Projekt und wählen Sie dann Model > 

Analyzer.
5 Doppelklicken Sie auf die entsprechende Schemadatei (*ShimConfig.xml), um sie in einem 

XML-Editor zu öffnen.
Wenn es mehrere shim-Konfigurationsdateien gibt, kennzeichnen Sie die mit jeder Datei 
verknüpfte Anwendung, indem Sie die Datei öffnen und den Inhalt der Tags <class-name>, 
<auth-id> und <auth-context> inspizieren.

6 Suchen Sie im XML-Editor nach den folgenden Elementen. Wenn sie nicht vorhanden sind, 
fügen Sie sie über dem schließenden Tag </shim-config> sofort zum Schema hinzu.

<app-schema-def>
   <schema-def>
...
   </schema-def>
<app-schema-def>

7 Suchen Sie in IDS-Trace nach dem <NDS>-Tag und fügen Sie anschließend den Inhalt des 
<NDS>-Tags in das <schema-def>-Tag in der Datei *ShimConfig.xml ein.
Stellen Sie sicher, dass Sie das <NDS>-Tag nicht mit in die Datei *ShimConfig.xml kopieren.

8 Suchen Sie nach doppelten <ClassDef>-Elementen in der Schemadefinition und konsolidieren 
Sie alle <attr-def>-Attributdefinitionen unter einem einzelnen <ClassDef>-Element.

9 Speichern Sie die Änderungen an der Schemadatei (Strg+S) und starten Sie anschließend 
Analyzer neu.

5.10 Für die Übereinstimmung wird bei Verwendung von HSQL 
zwischen Groß- und Kleinschreibung unterschieden
Wenn Sie HSQL als Backend-Datenbank für Analyzer verwenden, wird bei der Übereinstimmung die 
Groß-/Kleinschreibung berücksichtigt. Wenn Sie MySQL als Backend-Datenbank verwenden, wird 
die Groß-/Kleinschreibung nicht berücksichtigt. (Bug 437550)

6 Verwenden des Produktevaluierungsschlüssels 
Sie können Analyzer vor dem Kauf des Produkts testen. Geben Sie zum Testen des Produkts nach 
dem Starten von Analyzer den Evaluierungsschlüssel C064 0010 0000 E203 2CCA im Feld „Lizenz“ 
ein. Der Produktevaluierungsschlüssel ist bis zu 14 Tage nach dem Starten des Produkts gültig. (Bug 
728283)
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7 Kontaktangaben
Wir möchten Ihnen stets eine nützliche, aussagekräftige Dokumentation an die Hand geben. Sie 
haben Verbesserungsvorschläge? Dann senden Sie sie uns per Email an Documentation-
Feedback@netiq.com (mailto:Documentation-Feedback@netiq.com). Wir freuen uns auf Ihre 
Rückmeldung.

Ausführliche Kontaktinformationen finden Sie auf der Website mit den Support-Kontaktangaben 
(http://www.netiq.com/support/process.asp#phone).

Allgemeine Informationen zu unserem Unternehmen und unseren Produkten finden Sie auf der 
NetIQ-Firmenwebsite (http://www.netiq.com/).

Werden Sie Mitglied in unserer Community (https://www.netiq.com/communities/), und führen Sie 
interaktive Gespräche mit Fachkollegen und NetIQ-Experten. In der NetIQ-Online-Community finden 
Sie Produktinformationen, Links zu nützlichen Ressourcen, Blogs und Social-Media-Kanäle.

8 Rechtliche Hinweise
Informationen zu rechtlichen Hinweisen, Marken, Haftungsausschlüssen, Gewährleistungen, 
Ausfuhrbeschränkungen und sonstigen Nutzungseinschränkungen, Rechten der US-Regierung, 
Patentrichtlinien und Erfüllung von FIPS finden Sie unter https://www.netiq.com/company/legal/.

Copyright © 2018 NetIQ Corporation. Alle Rechte vorbehalten. 
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